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Preface

This User Guide has been implemented by Boot & Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operate and get
a better understanding of the technical data of the signal modules, power supply
modules and interface modules.

Intended Audience
This User Guide is intended for the following audience:

Persons in charge of introducing automation devices.
Persons who design automation systems.
Persons who install or connect automation devices.

Persons who manage working automation installation.

& Warnings:

® It must be used a micro USB-B type cable with the plastic part thin (contour of 2mm).

e Unused pins should not be connected. Ignoring the directive may damage the
controller.

o Improper use of this product may severely damage the controller.

e Refer to the controller’s User Guide regarding wiring considerations.
Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

® Maintenance must be performed by qualified personnel familiarized with the
construction, operation, and hazards involved with the control.



Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

The 10 1/Os PLCs are Open Type Controllers. It is required that you install the 10 1/Os
PLC in a housing, cabinet, or electric control room. Entry to the housing, cabinet, or
electric control room should be limited to authorized personnel. Failure to follow these
installation requirements could result in severe personal injury and/or property
damage. Always follow these requirements when 10 1/Os PLCs.

In case of installation or maintenance of the 10 1/Os please follow the instructions
marked in the Installation and Maintenance section.

Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

Il faut utiliser un cable de type micro USB-B avec la partie plastique fine (contour de
2mm).

Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le contréleur.

Une utilisation incorrecte de ce produit peut endommager gravement le controleur.
Reportez-vous au Guide de [l'utilisateur du contréleur pour les considérations de
cablage.

Avant d’utiliser ce produit, il incombe a l'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui 'accompagne.

La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contréleur.

La maintenance doit étre effectuée avec I'équipement hors service et déconnectée de
toutes les sources d'alimentation.

Faites attention lors de I'entretien des composants sensibles a |'électricité statique. Les
recommandations du fabricant pour ces composants doivent étre suivies.

Les automates de la famille 10 1/Os sont des contrdleurs de type ouvert. Il est
nécessaire d'installer I'automate 10 I/Os dans un boitier, une armoire ou une salle de
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contréle électrique. L'accés au boitier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation des automates de la
famille 10 1/Os.

En cas d'installation ou de maintenance du 10 1/Os, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

Ne débranchez pas I'équipement en présence d'une atmosphére inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmosphere
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.

Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED.
THEY SHOULD NOT BE RELIED UPON AS A SAFETY COMPONENT OR
PROTECTIVE DEVICE FOR ENSURING SAFETY OF PERSONS, AS THEY ARE
NOT RATED OR DESIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY
WITHOUT ENSURING THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED
TO ADDRESS THE RISKS, NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE
PROPERLY RATED AND INSTALLED FOR THE INTENDED USE WITHIN THE

OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use
of the product.

The following are some examples of applications for which particular attention must be
given. This is not intended to be an exhaustive list of all possible uses of the products,
nor is it intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.
e Nuclear energy control systems, combustion systems, railroad systems,
aviation systems, medical equipment, amusement machines, vehicles, safety



equipment, and installation subject to separate industry or government
regulations.

e Qutdoor use, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third-party
certification documents identifying ratings and limitations of use that apply to the
products. This information by itself is not sufficient for a complete determination of the
suitability of the products in combination with the system, machine, end product, or
other application or use.

Intended use or of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in
the catalogue and the associated technical documentation. If third-party products and
components are used, they must have been recommended or approved by Industrial
Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct
manner. It must respect the permissible ambient conditions. You should also follow the
indications and warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or
manipulated by qualified personnel for the task entrusted and observing what is
indicated in the documentation corresponding to it, particularly the safety instructions
and warnings included in it. Due to their training and experience, qualified personnel
are in a position to recognize risks resulting from the handling or manipulation of such
products / systems and to avoid possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing
purposes, even when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in
determining suitability and does not constitute a warranty. It may represent the result of
INDUSTRIAL SHIELDS’s test conditions, and the users most correlate it to actual
application requirements. Actual performance is subject to the INDUSTRIAL SHIELDS
Warranty and Limitations of Liability.



Change in Specifications

Product specifications and accessories may be changed at any time based on
improvements and other reasons.

It is our practice to change model numbers when features are changed, or published
ratings or when significant construction changes are made. However, some
specifications of the products may be changed without any notice. When in doubt,
special numbers may be assigned to fix or stablish key specifications for your
application on your request. Please consult with your INDUSTRIAL SHIELDS
representative at any time to confirm actual specifications of purchased products.

Errors and Omissions

The information in this document has been carefully checked and is believed to be
accurate; however, no responsibility is assumed for clerical, typographical, or
proofreading errors, or omissions.

Residual Risks

The control and drive components of an Industrial Shields PLC are approved for
industrial and commercial use in industrial line supplies. Their use in public line
supplies requires a different configuration and/or additional measures. These
components may only be operated in closed housings or in higher-level control
cabinets with protective covers that are closed, and when all of the protective devices
are used. These components may only be handled by qualified and trained technical
personnel who are knowledgeable and observe all of the safety information and
instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU
Machinery Directive, the machine manufacturer must consider the following residual
risks associated with the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning,
operation, maintenance, and repairs caused by, for example: — Hardware defects
and/or software errors in the sensors, controllers, actuators, and connection technology
- Response times of the controller and drive — Operating and/or ambient conditions not
within the scope of the specification — Condensation / conductive contamination -
Parameterization, programming, cabling, and installation errors — Use of radio devices /
cellular phones in the immediate vicinity of the controller — External influences /
damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by,
for example: — Component malfunctions — Software errors — Operating and/or
ambient conditions not within the scope of the specification - External
influences / damage.

3. Hazardous shock voltages caused by, for example: — Component malfunctions -
Influence of electrostatic charging — Induction of voltages in moving motors — Operating
and/or ambient conditions not within the scope of the specification - Condensation /
conductive contamination — External influences / damage



4. Electrical, magnetic and electromagnetic fields generated in operation that can pose
a risk to people with a pacemaker, implants or metal replacement joints, etc. if they are
too close.

5. Release of environmental pollutants or emissions because of improper operation of
the system and/or failure to dispose of components safely and correctly.

Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in
materials and workmanship for a period of one year (or other period if specified) from
date of sale by Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY,
EXPRESSED OR IMPLIED, REGARDING MERCHANTABILITY,
NON-INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE OF THE
PRODUCTS. ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR
USER ALONE HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET
THE REQUIREMENTS OF THEIR INTENDED USE. INDUSTRIAL SHIELDS
DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT,
OR CONSEQUENTIAL DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN
ANY WAY CONNECTED WITH THE PRODUCTS, WHETHER SUCH CLAIM IS
BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONSIBLE FOR WARRANTY,
REPAIR OR OTHER CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL
SHIELDS’S ANALYSIS CONFIRMS THAT THE PRODUCTS WERE PROPERLY
HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT SUBJECT TO
CONTAMINATION, ABUSE, MISUSE, OR INAPPROPRIATE MODIFICATION OR
REPAIR.
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1. 10 I/0s Module: General Features

COMPACT PLC 10 I/Os MODULE PLC

Fuse protection (2.5A)

Input Voltage 12 to 24Vdc Polarity protection
Input rated voltage 24Vde
Rated Power 30W
| Max. 1,5A

Size 100x45x115
Clock Speed External: 240 MHz Internal: 8 MHz

External Flash Memory 4MB
SRAM 4 MB
PSRAM 2 MB

Communications

USB - RS485 — ETH — WiFi — BLE

MAX487CSA - W5500

MAX Input points 10
MAX Output points 10
3.3 to 24Vdc
Freq: 10 Hz

Digital Input 10bit
3,3 —24Vdc

Input Impedance: 27K
Separated PCB ground

I min: 2 to 12mA
Opto-isolation
Rated Voltage: 24 Vdc

Digital Isolated Output
Relay

30Vdc / 250Vac
Galvanic Isolation
Diode protected for Relay

Imax: 3A (30Vdc)
Imax: 5A (250Vac)

Expandability

USB — RS485 - ETH — WiFi — BLE

Reference

IS. 013001000100
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2. Technical Specifications

2.1  General Specifications:

Power supply

voltage DC power supply

12 to 24Vdc ==

Operating

voltage range DC power supply

11.41t0254Vdc ===

Power

consumption DC power supply 30W max.
Power supply voltage 24Vdc ===
External
power supply
Power supply output 300mA

capacity

Insulation resistance

20MQ min. at 500Vdc between the AC terminals and the protective ground
terminal.

Dielectric strength

2.300Vac at 50/ 60 Hz for one minute with a leakage current of 10mA max.
Between all the external AC terminals and the protective earth terminal.

Shock resistance

80m/s? in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0° to 60°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage) -20° to 60°C
Power supply holding time 2ms min.
Weight 350g max.
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2.2 Performance Specification:

Board ESP32 DevKit C (3.3V)
Control method Stored program method
1/0 control method Combination of the cyclic scan and immediate refresh processing methods.

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform
Programming language composed of a programming language. “similar to the C”.
http://arduino.cc/en/Tutorial/HomePage

Microcontroller ESP32
External Flash Memory 4MB
Program capacity (SRAM) 4MB
PSRAM 2MB
Clock Speed 8MHz

2.3 1010s Pinout

10s Table
Analog Digital Isolated Digital Isolated Digital/Analogic Relay
Model Reference Input Input Output Output Output
10 10s 013001000100 4 2 0 3 8

10 10s Module allows multiple
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2.4 Symbology

Table that includes all the symbology that is used in the serigraph of the PLC 10 I/Os Module:

Svmbol Standard No. / Standard
y Standard Title Reference No. / Symbol Meaning
Symbol Title
IEC 60417 / , . .
I Graphical symbols 5031 / Direct Inqlcates that. the equipment |§
HEE BN suitable for direct current only;
for use on Current ) . )
: to identify relevant terminals
equipment
IEC 60417 / Indicates that the equipment is
Graphical symbols , suitable for alternating current
N for use on 5032 / Alternating only; to identify relevant
) Current .
equipment terminals
IEC 60417 /
Graphical symbols 5130 / Pulse To identify the pontrol by which
for use on a pulse is started.
. General
equipment
IEC 60417 / To identify an earth (ground)
Graphical symbols terminal in cases where
for use on 5017/ Earth, neither the symbol 5018 nor
. Ground , o .
equipment 5019 is explicitly required.
IEC 60417 / . . .
Graphical symbols To identify the swﬂch by
means of which the signal
for use on 5115/ Signal lamp . .
) lamp(s) is (are) switched on or
equipment

off.

Medical Devices

CE marking indicates that a
product complies with

Directive CE Marking . .
93/42/EEC applicable European Union
regulations
ISO 7000/ : :
Graphical symbols Indicates a potentially
P y 0434B / hazardous situation which, if
for use on . . k
. Warning symbol not avoided, could result in
equipment : g
death or serious injury
ISO 7000/
Gra;])chlcal symbols 5036 / Dangerous To indicate hazards arising
or use on
. Voltage from dangerous voltages
equipment
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3. Precautions

Read this manual before attempting to use the 10 1/Os PLC and follow its descriptions for
reference during operation.

3.1 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.2 General Precautions

The user must operate 10 |/Os Module according to the performance specifications described
in this manual.

Before using 10 1/Os PLC under different conditions from what has been specified in this
manual or integrating 10 1/0Os Module to nuclear control systems, railroad systems, aviation
systems, vehicles, combustion systems, medical equipment, amusement machines, safety
equipment and other systems, machines, and equipment that may have a serious influence on
lives and property if used improperly, consult your INDUSTRIAL SHIELDS representative. Ensure
that the rating and performance characteristics of 10 I/Os Module are sufficient for the
systems, machines, and equipment, and be sure to provide the systems, machines, and
equipment double safety mechanisms. This manual provides information for programming and
operating the 10 1/0s Module.
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4. Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed directly using C but it is much easier working with
Arduino IDE as it provides lots of libraries that help in the programming.

Furthermore, Industrial Shields provide boards for programming the PLCs much easier.
Basically, it is not needed to define the pins and if those pins are inputs or outputs. Everything
is set up automatically if using the boards.

In order to install Industrial Shields boards, these are the steps that must be followed.
Requirements:

Arduino IDE 1.8.0 or above (better to always have the latest version).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences X

Settings  Network:

Sketrhbook: location:

C:\Users\Albert\Documents\Arduino Browse
Editor language: English (English) | (requires restart of Arduino)

Editor font size: 15

Interface scale: Automatic | 100 5 %  (requires restart of Arduino)

Show verbose output during: compilation upload
Compiler warnings: None

[ pisplay line numbers

[CJEnable Code Folding

Verify code after upload

[Juse external editor

Check: for updates on startup

Update sketrh files to new extension on save (.pde -> .ino)
Save when verifying or uploading

Additional Boards Manager URLs: |hittp://apps.industrialshields.com/main/arduino/boards fpackage_industrialshields_inde:| 21

More preferences can be edited directly in the file
C:\Users\Alber t\AppData\local\Arduino15 \preferences. txt
(edit only when Arduino is not running)

OK Cancel

2. In Additional Boards URLs write the following:

If you already have an URL inserted, input an “” between both URLs.

3. Press OK to save the changes.
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4. Go to: Tools -> Board: ... -> Boards Manager

@ sketch_jan13a Arduino 1.8.13 - O X
Archivo Editar Programa Herramientas Ayuda
Auto Formato Ctrl+T
Archivo de programa.
Reparar codificacién & Recargar.

sketch_jan13a
Administrar Bibliotecas.. Ctrl+Maytis+1

. ~
void setup(  woniorserie Ctri+Maytis+M
/ / put yda Serial Plotter Ctri+Mayis+L  hnce
WiFi101 / WIiFININA Firmware Updater
} Placa: "Ardbox family” 2 Gestor de tarjetas...
Model: "Ardbox Relay HF+ w/ HW RS-485" 4 Arduino AVR Boards >
Puerto ESP32 Arduino >
vold loop ()  Obténinformacion de la placa Industrial Shields boards >
>
b A Programador 4 Industrial Shields ESP32 modules v

Quemar Bootloader

5. Search for industrialshields.

@ Gestor de tarjetas x
Tipo Todos | lindustrialshields]
industrialshields ~

versin 1.1.29 INSTALLED

Tarjetas induidas en éste paquete

ARDBOX family, ARDBOX DALI family, ARDBOX GPRS family, ARDBOX LoRa family, ARDBOX WiFi/BT family, M-Duino family, M-Duino DALT family,
M-Duino GPRS family, M-Duino LoRa family, M-Duino WiFi/BT family, Spartan family.

Online Help

More Info

industrialshiekds-esp32

version 1.0.2 INSTALLED
Tarjetas incluidas en éste paquete
WIiFi/BT module.

Online Help

More Info

Seleccione versién Instalar Eliminar

v

Cerrar

6. Click install industrialshields-esp32 (selecting the latest version).

Following this steps you will be able to use now the Industrial Shields Boards:

@ sketch_jan13a Arduino 1.8.13 — a X
Archivo Editar Programa Herramientas Ayuda

Auto Formato Ctrl+T
Archivo de programa.

sketeh janida Reparar codificacion & Recargar.
Administrar Bibliotecas.. Ctri+Mayus+|
Monitor Serie Ctri+Mayus+M

Serial Plotter Ctrl+Mayus+L
WIiFi107 / WIiFiNINA Firmware Updater

S Placa: "10 10S PLC Family” 3 Gestor de tarjetas...
// put y Model: *10 10S PLC Digital” ) Arduino AVR Boards »
Puert ESP32 Arduino >
Obtén informacién de la placa Industrial Shields boards >
} \ Industrial Shields ESP32 modules > WiFi module ~

Programador .
Quemar Bootloader ® 10105 PLC Family




Once it is selected the 10 10s PLC in Industrial Shields ESP32, an extra option will appear on
Tools:

@ sketch_jan13a Arduino 1.8.13 — O x
Archivo Editar Programa Hemramientas Ayuda

Auto Formato Ctrli+T
Archivo de programa.

Reparar codificacion & Recargar.

sketch_jan13a
Administrar Bibliotecas... Ctrl +Mayus+|
Monitor Serie Ctrl +Mayds+M
Serial Plotter Ctrl +Mayts+L

WIiFi101 / WiFININA Firmware Updater

S Placa: “10 I0S PLC Family” »

// put ydl  Modek 10105 PLC Relay" 3 1010SPLC Digital |:
Puert ® 10105 PLC Relay
Obtén informacion de la placa

Programador >
Quemar Bootloader

10 108 PLC Family

There, it can be selected the exact model for every family. In this case 10 10s PLC Relay.

Install the following driver depending on the operating system you use in order to work
comfortably with the ESP32-based PLC.

Also, there are some examples of programming in File -> Examples -> 10 1/Os PLC Family.
Furthermore, there are some extra libraries that can be found in Industrial Shields GitHub.

https://github.com/IndustrialShields/
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5. How to connect 10 I0s to PC

Connect USB port from PLC to PC.

NOTE:
10 1/0s PLC uses micro USB cable.

- Open Arduino IDE interface:
- Select the correct board.
- Select the correct port.

@ sketch_sep21a | Arduino 1.8.10

file Edit Sketch Tools Help

Auto Format Ctrl+T
Archive Sketch

Fix Encoding & Reload

Manage Libraries... Ctrl+Shifts1 7S
Serial Monitor Ctrl+Shift+M
Serial Plotter Ctrl+Shift+L

to run once:
WiFi101 / WIFININA Firmware Updater

Board: “DOIT ESP32 DEVKIT V1
} Upload Speed: "921600"
Flash Frequency: "80MHz"
. Core Debug Level: "None™
void 1 pmmper
// pi  Getsoardinio @Mt epeatedly:

Programmer: “AVRISP mkll* >
Bum Bootloader

Serial ports

DOIT ESP32 DEVKITV1 on COM10.
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6. How to connect PLC to power supply

- 101/0s PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT REVERSAL!
- Make sure that the live and GND connector of the power supply match the PLC.

- Make sure that the power supply mains output is not higher than 24Vdc.

I::".'.T ER SUP PL:I

| Lo

I I—f 24V

| I ——— |

- Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm
M Rail:

-12vdc J 24vdc

-2.58

-30W

Industrial Shields power supplies provide parallel
operation, overvoltage pratection, and overcurrent
protection. There is a LED inductor for power status, the
power supply is certified aceording to UL

¥

L T

ie 0.

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types

of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-1.

WARNING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of the

equipment must be separated from the dangerous voltage cables.
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7. 101/0s serigraphy

10 1/0s ESP32 .
. Function
Connector Pin
GND 2 - Ground
10.9 G13 Digital Input
10.8 G12 Digital Input
10.7 G14 Digital Input
10.6 G27 Digital Input
10.5 G26 Digital Input
GND 1 - Ground
10.4 G25 Digital Input
10.3 G32 Digital Input
10.2 G15 Digital Input
10.1 G2 Digital Input
10.0 G4 Digital Input
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10 1/Os ESP32 .
. Function
Connector Pin
1
W
R9 G13 Relay Output i
R8 G12 Relay Output Relay Pins
R7 G14 Relay Output
R6 G27 Relay Output =
R5 G26 Relay Output M 5 25
com2 - Common 2 gada Ay —
< |[Z-/am
R4 G25 Relay Output ks
R3 G32 Relay Output ,_
R2 G15 Relay Output R4
R1 G2 Relay Output = Common 2
RO G4 Relay Output
COM1 - Common 1
5
b s
R4
R3 .
Relay Pins
Re
R1
RO
ciM 1
258
| 228 Common 1
xS L




()]
+ (ON®)
Sz =z L
- e
—_— = \vV,
I I.
—
L —'
aND RS485 l\ MUST NOT BE MICRO ETHERNET POWER
pins . CONNECTED USB

NOTE: In case you need to activate the reset button, it can be found by opening the top cover
and accessing the white reset button of the ESP32 board integrated inside the enclosure.

NOTE: The LEDs positioned at the top of the PLC, which go from led 0 to 9 refer to both inputs
and outputs.

For example, if you are using input 10.9, LED 9 on the top cover of the PLC will indicate the
signal status of this input.

If output Q0.9 is being used, LED 9 on the upper cover of the PLC will indicate the status of the
signal of this output.

An input and an output with the same nomenclature can never work at the same time (see
jumper configuration on section 7).
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8. Software set up

Whether they are digital or relay, the inputs and outputs must be configured in the set up part
of the code, like it is usually done in common Arduino boards. The function that must be used
is pinMode(), like it is explained on the official Arduino website:

https://www.arduino.cc/reference/en/language/functions/digital-io/pinmode

8.1 Example

If you want to configure an input, it can be done this way:

pinMode(10_0, INPUT);

@ sketch_dec20a Arduino 1.8.13

Archivo Editar Programa Herramientas Ayuda

(R

void setup() {
// put your setup code here, to run once:
pinMode(I@ ©, INPUT);
.begin(9600);

void loop() {
// put your main code here, to run repeatedly:
.println(digitalRead(I©_0));

i
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If you want to configure an output, it can be done this way:

pinMode(R0_5, OUTPUT);

@ sketch_dec20b Arduino 1.8.13
Archivo Editar Programa Herramientas Ayuda

';etup() {
// put your setup code here, to run once:

pinMode(R@®_5, OUTPUT);
.begin(9600);

void loop() {
// put your main code here, to run repeatedly:
digitalWrite(R®_5, HIGH);
delay(1000) ;

digitalWrite(RO 5, LOW);

You have to consider that the software configuration must match with the jumper
configuration and that the same GPIO cannot be used as INPUT and OUTPUT at the same time,
as it was previously explained.

24



9. I/0s Communications

9.1 RS485

The RS-485 is a half-duplex serial communication. The 10 I/Os PLC uses the MAX841CSA for the
RS-485 communication. In the following image you can see the internal schematic of the PLC of

the connection between microcontroller pins, the RS-485 chip and its outputs.

DE
X

10 1/0s PLC
4 N
A+
MAX481CSA | &
- J

Using the boards of Industrial Shields, there is a library that simplifies the RS-485

implementation.

9.2 Ethernet

10 1/Os Ethernet port controller is based on w5500 IC, which is the IC compatible with Arduino
Ethernet2 Shield libraries. All Ethernet shield Arduino libraries are compatible with the 10 1/Os.
In the 10 I/0Os PLC, W5500 IC communicates to the microcontroller board via SPI bus.
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9.3 WiFi&BLE

The WiFi and Bluetooth integrated module consists of a single 2.4 GHz Wi-Fi and Bluetooth
combo chip designed with the TSMC ultra-low-power 40 nm technology. It is designed to
achieve the best power and RF performance, showing robustness, versatility and reliability in a
wide variety of applications and power scenarios. Some applications are Generic Low-power
loT Sensor Hub, Generic Low-power loT Data Loggers and Mesh Network.

It is designed for Internet-of-Things (loT) applications.

General Specifications

Wi-Fi

e 802.11 b/g/n

e 802.11 n (2.4 GHz), up to 150 Mbps
Bluetooth

e Bluetooth 4.2 BR/EDR BLE dual mode controller
e +12 dBm transmitting power
e NZIF receiver with -97 dBm BLE sensitivity
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10. Typical Connections
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11. Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT — 1963502 from
Phoenix contact. MC0,5/10-G-2,5THT

For I/0 and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference MC 0,5/10-G-2,5
THT
Height 8,1Imm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm
Article reference FK-MC 0,5/10-ST-2,5
Rigid conduit section min. 0,14 mm?
Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?
Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20
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https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1963502&library=usen&tab=1
https://www.phoenixcontact.com/online/portal/us?uri=pxc-oc-itemdetail:pid=1881406&library=usen&tab=1#General

12.

10 I/0s Dimensions:

DIN rail mounting:
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13.Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which are apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause a misact.

- Use shielded twisted pairs for the 1/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particles,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the 10 I/Os MODULE from heat, high voltage and electrical noise:

Always separate the devices that generate high voltage and high electrical noise from the
10 1/Os Module. When configuring the layout of the 10 I/Os Module inside your panel,
consider the heat-generating devices and locate the electronic-type devices in the cooler
areas of your cabinet. Reducing the exposure to a high-temperature environment will
extend the operating life of any electronic device. Also consider the routing of the wiring
for the devices in the electric cabinet. Avoid placing low-voltage signal wires and
communications cables in the same tray with AC power wiring and high energy, rapidly
switched DC wiring.
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Provide adequate clearance for cooling and wiring 10 1/Os Module. Is designed for natural
convection cooling. For proper cooling, you must provide a clearance of at least 25 cm above
and below the devices. Also, allow at least 25 cm of depth between the front of the modules
and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a way
that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquid filled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess
temperature.

- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.
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- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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14. Revision Table

Revision Number Date Changes
0 21/09/2020 First implementation
1 03/06/2021 Section 1 modified
2 20/12/2021 Section 9 added
3 25/03/2022 Micro USB warning added
4 12/05/2022 Section 1 modified
5 15/06/2023 New 10 10s implementation
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About Industrial Shields:

Direction: Fabrica del Pont, 1-11

Zip/Postal Code: 08272

City: Sant Fruités de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635 693 611

Mail: industrialshields@industrialshields.com
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